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APA Assignment: General Page Format Requirements

Academic writing at Confederation College must always be formatted according to APA
guidelines.

How to Format an APA Document

Font
Use one of the following APA fonts: 12 pt. font, Times New Roman or 11 pt. font, Calibri (Body).

How to Change the Font Size. To change the font, click on the “Home” tab in Microsoft Word,
and choose the style and font size in the dropdown menus (A and B), as pictured in Figure 1.

Figure 1
How to Change the Font Size
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Page Margins
Your document must have 1” (one inch) page margins on the top, sides, and bottom of the
document.

How to Check the Page Margin Size. Click the “Layout” tab (A) in Microsoft Word, and click
the “Margins” drop down arrow (B). Click on the “Normal (2.54 cm)” margin selection (C), as
pictured in Figure 2.

Figure 2
How to Check the Margin Size
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Paragraph Alignment

All assignment paragraphs (for essays, formal reports, or informal reports) must be ragged, left
aligned. You should never manually adjust the word spacing or hyphenate any words to make
the paragraph flush with both margins.

How to Make an Assignment Left Aligned. Under the “Home” tab, click the left align button
(A), as shown in Figure 3.

Figure 3
How to Make Paragraphs Left Allgned
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APA Assignments: How to Format Mandatory Components

There are mandatory components that, unless otherwise indicated by your Confederation College
professor, must accompany all assignments that you submit. Every assignment must have an
APA title page, and if you have taken any information from a secondary source, you must also
include an APA References page. See the References section of this guide for the References
page formatting instructions.

APA Title Page

Your APA title page is the first page of your assignment, and it must abide by APA guidelines.
Follow the long instructions in Figure 6 or use the short instructions in Figure 5 to create an APA
title page

If you have followed the directions to create an APA title page, the layout of your APA title page
should look exactly like the title page in Figure 4. If it does not look identical, you have missed
a step, and therefore, your APA title page is formatted incorrectly.



Figure 4
APA Title Page Example

A Condensed APA Guide for Confederation College Students

Deborah Bourgeois
CS 050 AO1: College Writing
Professor Cedar Nicholl

October 12, 2020|




How to Create an APA Title Page
Figure 5
APA Title Page: Short Instructions

Title of
assignment,
written in bold
font and in title
case

Student’s name Deborah Bourgeois

CS 050 A01: College Writing

Course code, section: Name of the

course Professor Cedar Nicholl

October 12, 2020|
Professor’s name

Date written in Month Date, Year
format

A Condensed APA Guide for Confederation College Students

|

2 Blank double-
spaced lines

2 Blank double-
spaced lines

Double spaced




Figure 6

How to Create an APA Title Page in Microsoft Word

Step

1. A) Click the “Insert” tab

B) Click the “Page
Number” drop down
menu

C) Hold your mouse
over the “Top of the
Page”

D) Click the “Plain
Number 3” option

2. A) Double click under
the “Header” area to
access the first line of
the title page

What it Looks Like in Microsoft Word

3. A) Click the “Home” tab
B) Click the “No
Spacing” button

Home Insert Draw Design Layout References Mailings Review View Help Table Design Layout

A Aa = - 2L 9 sadncodes | AaBbCODdE] AaBBCeDl ASBBCeDA] AaBbCeDdE

v A
Uvab x, x Av2~A~ v <0 <[ | TNormal |1No Spac

Heading1 Heading2 Heading 3

Styles
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Step (Cont’d)

4.

A) Click the “Home” tab

B) Click the “Spacing”
button

C) Select the 2.0 line
spacing option

What it Looks Like in Microsoft Word (Cont’d)

B9-0B

Documentd - Word £ search

From the first line of the
document, press the
“Enter” key on your
keyboard two times,
which will bring your
cursor to the fourth line
of the document.
A) Click the “Home”
tab
B) Click the “Bold”
button
C) Click the “Centre”
button
D) In title case (see
definitions page),
type in the title of
your assignment

P search

5 Mallings  Review View Help

1 sambccnce | assbtendee | 4aBhCE

Cipbeard 3

H Comments

A)

From the title line, press
the “Enter” key on your
keyboard two times,
which will bring your
cursor four lines below
the title line.

Click the “Bold” button
to remove the bold font.
Type your first name and
last name, as it appears
on your Confederation
College registration
documents. If thisisa
group assignment, type
all group members’
names. Use a comma to
separate each name.

Title of the Assignment

Deborah L. Bourgeois m
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Step (Cont’d)

What it Looks Like in Microsoft Word (Cont’d)

7. Press the “Enter” key on
your keyboard once from
the author line.

A) Type in the course
information in the
following format:
Course Code
Section Number:
Course Name

Title of the Assignment

Deborah L. Bourgeois

CS 050 A01: College Writing <:B

8. Press the “Enter” key on
your keyboard one time
from the course line.

A) Type in your course
instructor’s preferred
name

Title of the Assignment

Deborah L. Bourgeois

CS 050 AOL: College Writing

Professor Cedar Nicholl <:B

9. Press the “Enter” key on
your keyboard one time
from the professor line.

A) Type in the due date
of the assignment in
the following
format: month date,
year

Title of the Assignment

Deborah L. Bourgeois
CS 050 A01: College Writing

Professor Cedar Nicholl

October 12, 2020 <:B
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Step (Cont’d) What it Looks Like in Microsoft Word (Cont’d)
10. With your cursor placed
at the end of the date

line, do the following:

A) click the “Insert” tab %;ﬂ V‘:: e T oMttt A Getaddns W

ank Page ] il chart

B) Press the “Page ----- Models ~ f. Screenshot

Break” button. This '

will bring you to the | |-

first line of the .

second page of your | |-

assignment file.

O Search

File Home Mailings  Review

(1’3 My Add-ins ~ Wikiped

Pages Tables lllustrations Add-ins

Title of the Assignment

Deborah L. Bourgevis
CS 050 AOL: College Writing

Professor Cedar Nicholl

October 12, 2020

11. FOR ESSAYS ONLY: File  Home

References  Mailings  Review View Help

On the ﬁrSt Iine Of the |D Times NewWor ¥ |12 v A" A AsBbCcDdEe | AaBbCeDdEe | AaRbCcD( Asbh Ad
second page, do the e o BT U %X A2 A ool [N Spc.| Headng 1 Heading 2
following: " ;
A) Click the “Home”

tab

B) Click the “Bold” : ﬂ e e N
button : g s e

C) Click the “Centre”
button

D) Type in the title of
the assignment

E) Press the “Enter”
key on your
keyboard once, left
align the text, and
begin typing your
assighment.

APA References Page

The References page contains a list of all of the sources that you paraphrased, quoted, or
summarized in your paper. See the “Avoiding Plagiarism” section for more information about
what sources you need to cite and reference. See the “References” section of this guide for more
information about how to format the References page and how to create each reference entry.
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APA Research Essay: Formatting & Organization
Essay Spacing
Academic essays bust be double-spaced. There are no extra spaces between the paragraphs.

How to Double Space an Academic Essay

Click the “No Spacing” button (B) under the “Home” tab (A). Next, click the spacing button
under the “Home” tab (C), and then click the “2.0” option (D) from the spacing drop-down
menu, as shown in Figure 7.

Figure 7
How to Double Space an Academic Essa

AutoSave (@ off) AN ON=N L APA Guide Qutl... =

2 Search Krista K

File Home

< 2 — — = = o=|a OFind ~

Times NewRor (12 ~|A” A" Aav fp | i=vi=svisvy == 4 T BbCCDdE 7 D @
|_D A BbCcDAE| A; 1| & Replace (=]
"ajte o BIU-abx ¥ A2 -A. E===I=° C [rospec| K - - =| | [ Select~ D'Llalt‘ Editor

Clipboard & Font [ Para ! Styles [ Editing Voice Editor
T 112 115 0 e s e s

Line Spacing Options

Add Space Before Paragraph

Add Space After Paragrapt

out References Mailings Review View Help 1% Share i Comments

Essay Paragraphs
Each paragraph must be indented by 0.5 inches (0.5”).

How to Indent Paragraphs in an Essay
To indent a paragraph by 0.5, press the “Tab” button once on your computer keyboard. See
Figure 8 for an example.

Figure 8
Example of Indented Paragraph Format for Essays
nrl LD SR LN SECEN B 3 [ ] Q¢ 1 v o1 LINCNE - B 9 101 11 12 1T 13" 19 1T 1o 16 O VAN DD ¢ - JONN B

The entire document is double spaced
The first line of each paragraph is indented by 0.5”
There is not an extra space separating the paragraphs.

- All paragraphs in an academic essay must be double spaced and ragged left aligned. Each
paragraph should abide by the paragraph structure taught in the CS050 class.
To differentiate between paragraphs, the first line of each paragraph must be indented by 0.5”.

To indent the first line of the paragraph, click the “Tab” key on your keyboard once. As you can see, the

two paragraphs in this example utilize the indent and double spacing needed in an academic essay|
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Essay Parts & Order

A research essay written in APA format must contain mandatory components: title page, essay,
and a references page. Unless you have been instructed otherwise by your professor, organize
your essay in the order outlined in Figure 9.

Figure 9
APA Essay Order
Essay Part Position Specifications Level of Heading
in Essay
Title Page 15t APA formatting Specific formatting
Has its own page required
Essay 2nd Begins indented and double spaced | No headings
on the second page, one double
spaced line below the title of the
assignment, which is written in bold
and centred on the first line of the
second page.
References Page [ 7t APA formatting Level 1 Heading
Has its own page Specific formatting
required

APA Formal, Informal, & Lab Reports: Formatting & Organization

Report Spacing
Formal or informal report must be single-spaced. There is one extra space between paragraphs
as shown in Figure 11.

How to Single Space an Informal or Formal Report

To make your informal or formal report follow proper APA spacing guidelines, your report must
be single spaced, block left aligned. To ensure your assignment is block left aligned, under the
“Home” tab (A), click the “No Spacing” button (B). Next, click the spacing button (C) under the
“Home” tab, and then click the “1.0” button (D) from the spacing drop-down menu, as shown in
Figure 10.

Figure 10
How to Block Left Align an Informal or Formal Report
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AutoSave @ o) [ D~ () B O APA Guide Outl... = O Search

Krista K

@

g X

File M but  References  Mailings Review \View Help 1% Share 2 Comments
ED Times New Ror ~[12 =A™/ =y =32 2l T | esbeendke |AaBbCeDE| Aa ﬂ r}'?:\:;a"’e L_.D_J é
Paste. 0 B I U~vabx ¥ A~ S0 4 o[~ | TNormal |TNoSpac..| HeadW 1 Heading SSE‘E(:, Do
Clipboard 3 Font [} para L 10 Styles (] Editing Voice Editor A
= raph
= Add Space After Paragraph
Formal & Informal Report Paragraphs
All paragraphs are block left aligned, and there is one extra space between paragraphs.
Paragraphs are not indented. See figure 11 for an example.
Figure 11
Example of Block Left Aligned Paragraph Format for Formal, Informal, and Lab Reports
2001010 120 3.0 4.1 516 78 g 110 11112 131 141 15 | - 16 171 181 + 19

Single space separates each paragraph

Each paragraph is flush with the left margin

All paragraphs in a formal report, informal report, or lab report will be block left aligned, and the
paragraphs will be flush with the left margin. Each paragraph should be formatted as ragged left alighed
and single spaced.

When formatting a new paragraph, insert a single-spaced line between the paragraphs to clearly identify
that new paragraph is separate from the paragraph before it. As you can see, these paragraphs are
written in the blocﬁ( left aligned format, and a single-spaced line separates the two paragraphs.

Formal Report Parts & Order

Unless otherwise stated by your Confederation College professor, organize your formal report in

the order outlined in Figure 12.

16




Figure 12

(Manization of a Formal Report

Report Part Position Specifications Level of Heading
in Report
Title Page 15t APA formatting Specific formatting
Has its own page required
Abstract 2nd Has its own page Level 1 Heading
Introduction 3rd Starts on the first page after the No heading
Abstract. Has the title of the
assignment written in bold font,
centred on the first line of the page,
before the text of the introduction.
Method 4t APA formatting Level 1 Heading
Continues after last line of previous
paragraph.
Findings / Results | 5t APA formatting Level 1 Heading
Continues after last line of previous
paragraph.
Discussion 6t APA formatting Level 1 Heading
Continues after last line of previous
paragraph.
References Page [ 7t APA formatting Level 1 Heading
Has its own page Specific formatting
required
Footnotes gth See instructor’s directions Level 1 Heading
Tables / Figu res Jo" See instructor’s directions Level 1 Heading
Appendices 10t See instructor’s directions Level 1 Heading

Headings Within a Report

In any academic assignment where you will require headings, like a formal or informal report,

you must use proper APA heading formats, as listed and illustrated in Figure 13. If you are
writing an informal or formal report, your mandatory report components, except for the
Introduction, will use the first level heading format listed in Figure 13.

17



Figure 13

Format for the Five Levels of Headings in APA Style

ISRV RTINS 1142 3 4.1 .5 6 7 8. 9 101 11 12 13 141 15 16 1701 18 )

First Level Heading
The first level heading is centred, has bold font, and is written in title case. All mandatory and
major sections of the assignment will use first level headings. The paragraph following the heading
starts as a new paragraph, like this paragraph has. First level headings function to separate all
major sections of the assignment.

Second Level Heading

The second level heading is left aligned, has bold font, and is written in title case. The paragraph
following the heading starts as a new paragraph, like this paragraph has. Second level headings
function to separate secondary parts of each major section of the assignment.

Third Level Heading

The third level heading is left aligned, has bold and italic font, and is written in title case. The
paragraph following the heading starts as a new paragraph, like this paragraph has. Third level
headings function to separate tertiary parts of each major section of the assignment.

Fourth Level Heading. The fourth level heading is indented, has bold font, is written in
title case, and ends with a period. The paragraph begins on the same line as the fourth level
heading, after the period, like this paragraph does. Fourth level headings function to separate
quaternary parts of each major section of the assignment.

Fifth Level Heading. The fifth level heading is indented, has bold and italic font, is
written in title case, and ends with a period. The paragraph begins on the same line as the fifth
level heading, after the period, like this paragraph does. Fifth level headings function to separate
quinary parts of each major section of the assignment.

Formatting Graphics & Tables Within an Assignment

Graphics effectively communicate a lot of information using a visual representation of the data.
Graphics must always communicate information related to the assignment topic. When
incorporating a graphic into your assignment, whether you create a graphic or the graphic is
taken from a secondary source, you must follow APA formatting and, if applicable, citation
guidelines.

Graphic / Table Placement

Unless you have been instructed to put graphics and tables into an appendix, all graphics and
tables placed in the body of the assignment must be left-aligned and flush with the left margin.
If a table runs onto a second page, you must repeat the headings on the second page.

Graphic / Table Placement Format. Once you have left-aligned your graphic, input one,
double-spaced line above the “Figure # line” and below the “Figure Note / Table Note” text box
to separate the graphic from the written content before and after it, as shown in Figure 13. The
graphic / table should be positioned as close to the callout paragraph as possible.
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Callout

You should never input a graphic/table into your paper without first addressing and discussing it,
which is commonly referred to as the “callout”. Because final editing and formatting of your
paper can change the layout of your assignment, never say, “the table below” or “the table on
page 5” in a callout. See the callout in Figure 14 for an example.

Figure 14
Callout Example

paper. My callout would look something like this: As indicated in Table 1, as of March 17, 2020, Ontario had
the highest number of confirmed cases of COVID-19 while Nova Scotia and Newfoundland and Labrador did
not have any confirmed cases of the virus.

Table 1

Provincial COVID-19 Cases as of March 17, 2020 . .
A i A e i Ry The callout is written before the

graphic and refers to the graphic
by table number or figure
number.

From Coronavirus Disease (COVID-15): Outbreak Update, by
Government of Canada, 2020 (https://www.canada.ca/en/public-
health/services/diseases/2019-novel-coronavirus-infection.html). In
the public domain

Once you have made the calloufand addressed the graphic by name, you need to format the graphic in a
specific way. You should attempt to place the graphic as close to the callout as you can, either closer to the top
or bottom of the page. Do not put the graphic on a separate page from the callout unless you absolutely have to.

Figure Number (for any graphic or image except for a table)

Every graphic must be labelled appropriately with a figure number. The first graphic that
appears in an assignment is labelled Figure 1, the second graphic that appears in an assignment is
Figure 2, and so on.

Figure Number Format. Once you have pasted the graphic into your paper and determined its
position number, type the Figure # in bold font, above the graphic. Left align the Figure # line to
the left margin of the page. Input a double-spaced blank line between the previous paragraph
and the Figure # line, as shown in Figure 15.

Table Number (for tables only)

Every table you input into your paper must be labelled appropriately with a table number. Table
numbers are determined by the table’s position in the paper in relation to other tables’ positions.
For example, the first table that appears in an assignment is labelled Table 1, the second table
that appears in an assignment is Table 2, and so on.
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Table Number Format. Once you have pasted the table into your paper and determined its
position number, type the Table # in bold font, above the table. Left align the Table # line to the
left margin of the page. Input a double-spaced blank line between the previous paragraph and
the Table # line, as shown in Figure 15.

Graphic and Table Titles

You must give all graphics and tables a title. The title should be short and should concisely
reflect the topic of the information presented in the graphic / table.

Graphic and Table Title Format. The graphic / table title is located one double-spaced line
below the “Figure #” or “Table #” line, and one single spaced line above the graphic or table.
The title must be written in title case and in italic font, as shown in Figure 15.

Figure 15
Example of a Taken Graphic

How to Format and Cite an Entire Graphic from a Secondary Source

If you are copying an entire graphic from a secondary source and pasting it into your paper, there are specific

ways to indicate that the graphic is from a secondary source. In fact, there is a specific way to discu,

graphic, to format the graphic, a special note that needs to be written in the graphic note section, an|
a specific way to reference the document that the graphic has come from. You should never copy
graphic into your paper without first addressing and discussing it: this is called the “callout™. A ca
you refer to the graphic by figure # (or table #) in your writing: you never want to say, “the table belo
table on page 5” in a callout. For example, if I was to copy and paste the graphic that I took the in
from in the previous paragraph, I would need to introduce it and discuss it before I actually pasted i y
paper. My callout would look something like this: As indicated in Table 1, as of March 17, 2020, Ontario had
the highest number of confirmed cases of COVID-19 while Nova Scotia and Newfoundland and Labrador did

not have any confirmed cases of the virus.

Table 1— Table #
rovincial COVID-19 Cases as of March 17, 2020 .

Provincial COVID-19 Cases 0 f — Table Title

From Coronavirus Disease (COVID-18). Outbreak Update, by
Gavernment of Canada, 2020 (https://www.canada ca/en/public-
health/services/diseases/2019-novel-coronavirus-infection.html). In
the public domain

Copyright Notation |

nce you have made the callout| and addressed the graphic by name, you need to format the graphic in a
specific way. You should attempt to place the graphic as close to the callout as you can, either closer to the top
or bottom of the page. Do not put the graphic on a separate page from the callout unless you absolutely have to.

General Graphic and Table Notes

A general table note explains or provides more details about information listed in the table /
graphic that may need explaining. For example, the definition of a special symbol or an
explanation of an uncommon abbreviation would be located in a table/graphic note.
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Mandatory Graphic and Table Notes

A graphic / table note is mandatory if you have taken or adapted a graphic from a secondary
source. Rather than an in-text citation, a taken or adapted graphic must have a copyright
attribution statement written in the graphic note or table note section, as shown in Figure 13.

The format of the copyright attribution depends on the type of source you have taken or adapted
the graphic from, so you will need to use Table 1 to correctly format the copyright notation. A
graphic is considered “taken” if you have cut and pasted the graphic, exactly as it was printed in
the original source, into the text of your paper. A graphic is considered “adapted” if you have re-
created the graphic using your own word processor, or if you have modified the graphic and/or
the information within it in any way.

A permission statement, as shown in Table 1, is not needed as long as you are using the graphic
for an educational purpose, you will not be making a profit by using the graphic, and you give
full credit to the original author using a copyright notation and reference entry.

Please note that all taken graphics must have a matching reference entry on the References page;
a copyright notation does not replace the need to have a reference entry.

How to Create a Graphic / Table Note Area. In Microsoft Word, click the “Insert” tab. Next
click the “Text Box™ button, and then click the “Draw Text Box” button. Using your cursor,
drag and draw a box under the graphic that you have inserted into your paper. Ensure that the
text box is the same width as the graphic. Place the text box immediately under the graphic.

How to Format a General Note In the graphic/table note area, type “Note.”, in italics. After the
period, write the explanation using non-italicized font.
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Table 1

Copyright Notation Formats
Mandatory Notation Components Source-Dependent

Reprinted /
adapted status

Source information

Copyright status

Permission statement
(include only if you need permission
because your work is not under
“fair use” policy)

Journal article, magazine article, or newspaper article

From
Or

Adapted from

“Title of Article,” by A. Author and B.
Author, year, Title of
Article/magazine/newspaper,
Volume(lssue)*, p. x (DOI or URL).

Copyright year by Name of
Copyright Holder.

Or

In the public domain.

Or

Creative Commons License.
(e.g. CC BY-NC)

Reprinted with permission.
Or

Adapted with permission.

1Example of a Copied Graphic from a Scholarly Journal Article Notation

From “Wrestling the Curve: Will Canada’s efforts to lessen the spread of COVID-19 push down our trajectory?,” by P. Treble, 2020,
Macleans, (May), p. 31
(https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login.aspx?direct=true&db=edsgao&AN=edsqgcl.621442
502&site=eds-live&scope=site). Copyright 2020 by Rogers Media.

Authored book or report

From
Or

Adapted from

Title of Book or Report (p. x), by A.
Author and B. Author, year, Publisher
(DOI or URL).

Copyright year by Name of
Copyright Holder.

Or

In the public domain.

Or

Creative Commons License.
(e.g. CC BY-NC)

Reprinted with permission.
Or

Adapted with permission.

Example of a Copied Graphic from a Textbook
From Language and Mathematics: An Interdisciplinary Guide (p. 5), by M. Danesi, 2016, Mouton
(https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login.aspx?direct=true&db=nlebk&AN=1250727 &site=

eds-live&scope=site). Copyright 2016 by Walter de Grouter Mouton Inc.

Edited book chapter (ie. Textbook)

From “Title of Chapter,” by A. Author and B. | Copyright year by Name of Reprinted with permission.
Author, in E. Editor and F. Editor Copyright Holder.
Or (Eds)., Title of Book (any edition or ?rth lic doma or
; n the public domain.
Adapted from VOEQE #, p. X), year, Publisher (DOI Or Adapted with permission.
or )- Creative Commons License.
(e.g. CC BY-NC)

Example of an Edited Book Chapter, if Copyrighted and if permission is needed
2From “Pharmacokinetics,” by V. Yellpeddi, in K. Whalen (Ed.), Pharmacology (6" ed., p. 2), 2015, Wolters Kluwer. Copyright 2015 by
Wolters Kluwer. Reprinted with permission.

Or

Title of Webpage, by Group Author
Same as Site Name, year (DOI or
URL).

Creative Commons License.
(e.g. CC BY-NC)

Webpage or website
From Title of Webpage, by A. Author and B. Copyright year by Name of Reprinted with permission.
Author, year, Site Name (DOI or Copyright Holder.
Or URL). Or Or
In the public domain.
Adapted from Or Adapted with permission.

Example of an Adapted Graphic from a Webpage
Adapted from Coronavirus Disease (COVID-19): Outbreak Update, by Government of Canada, 2020 (https://www.canada.ca/en/public-
health/services/diseases/2019-novel-coronavirus-infection.html). In the public domain.

Adapted from Concise Guide to APA Style: The Official APA Style Guide for Students (p. 209), by American Psychological Association, 2020,
The American Psychological Association. Copyright 2020 by The American Psychological Association.

a1 examples are being written from a student perspective, where permission would not be needed because the purpose of using the graphic is

considered “fair use”.

2 (American Psychological Association, 2020, Table 8.4)
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APA In-Text Referrals: Referring to a Source Within Your Assignment

An in-text referral simply means that you are writing the title of a secondary source within the
text of your paper. It is never appropriate to write, for example, “the book says ...”. You need
to write the title using APA formatting guidelines. The way in which you format the title of a
written work will depend on the type of written work that you are referring to. The formatting
rules for texts are listed in Table 2.

Table 2

In-text Referral Formatting

Type of Work

Formatting for In-Text Referral

Example

Stand-Alone Works

Book Title

Italicize the title and write it in title case.

When J. K. Rowling wrote
Harry Potter and the
Philosopher’s Stone, she used
a

Published Report

Italicize the title and write it in title case.

There were over 300 interviews
in Assessment Practices in the
Elementary Classroom:
Perspectives of Stakeholders, all
of which highlight ...

Webpage Name

Italicize the title and write it in title case.

Wikipedia is not a credible
secondary source because ...

Periodical / Journal
Title

Italicize the title and write it in title case.

The Lancet retracted Andrew
Wakefield’s study that linked
vaccines to autism ...

Brochure Italicize the title and write it in title case. Help Reduce the Spread of
COVID-19 outlined the
necessary steps to flatten the
curve ...

Film Italicize the title and write it in title case. The patriarchal gender norms in

The Incredibles serve to further

Work that is a part of a Stand-Alone Work

Periodical Article

Put double quotations before and after the
title of the article. Write the title in title
case.

Liao, Lai, and Chang’s (2019)
article, “Nutrition Literacy is
Associated with Healthy-Eating
Behaviour among College
Students” outlined...

Chapter

Put double quotations before and after the
name of the Chapter. Write the title in title
case.

In “Mechanics of Style,” the
nuances of punctuation is ...

Article from a News
Site / Newspaper

Put double quotations before and after the
title of the article. Write the title in title
case.

Cullen and Everson (2020) in
“Canadians Who Don’t Qualify
for CERB are Getting it
Anyway — and Could Face
Consequences” outlined the
consequences of fraudulent ...
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Avoiding Plagiarism

Confederation College defines plagiarism as “an act of knowingly or unknowingly representing
another person’s words or ideas as one’s own” (“Academic Integrity”, 2015, p. 1). When writing
an assignment, you must always acknowledge when the words and/or ideas and/or information
have been taken from a source, whether it is a digital or physical source.

Sometimes, students will accidentally plagiarize by not correctly using APA in-text citations, not
paraphrasing or summarizing properly, or failing to properly document taken information in the
References page. On the other hand, students typically knowingly plagiarize when they hand in
an entire assignment or a portion of an assignment that is not their own.

The consequences of plagiarism vary, based on the severity of the incident. However, at
Confederation College, if a student knowing or unknowingly plagiarizes from another source,
any of the following consequences can occur:

» The student receives a 0 for the assignment in question

* The student fails the course

» The incident gets reported in the Academic Integrity Reporting System

» The student will be put on academic probation

« The student receives a permanent note put on their academic transcript, which will impact

the student’s application consideration at other academic institutions
» The student is suspended from Confederation College
» The student is expelled from Confederation College

To prevent unknowingly plagiarizing, when writing any assignment, every student at
Confederation College must follow the “Anti-Plagiarism Formula” shown in Figure 16.

Figure 16
Anti-PIagiarism Formula

Taken In-Text Reference CORRECT &
Information Citation Entry NOT

L . ..{::. _ PLAGIARIZED
(any taken —|_|— (Narrative or (Listed on the e

information / idea, Parenthetical) References page) ASSIGNMENT
summary,
paraphrase, or direct
guote)

]
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Taken Information

It is okay to use the research, words, and/or ideas of others’ to incorporate into your assignments,
as long as you abide by the Anti-Plagiarism Formula: provide an in-text citation in the body of
your assignment, and a matching reference entry on the references page.

If you are taking information from another source, you can present that information in three
ways: a summary of the information, a paraphrase of the taken information, or a direct quotation.

Summary

A summary is when you briefly recap the general points of information that was made in the
source that you are borrowing your information from. Summaries must have an in-text citation;
however, because summaries can cover an entire work, a page or paragraph number is not
needed in the in-text citation.

How to Create an In-Text Citation for a Summary

Once you have summarized the information, you need to create an in-text citation (parenthetical
or narrative) for the summarized material. For a narrative in-text citation, in the signal phrase,
input the original source’s publishing date in round brackets immediately after the last author’s
surname to identify that you have summarized the information that follows it from another
source. For a parenthetical in-text citation, only list the author’s surname and the year of
publication.

Paraphrase

When borrowing any idea or information from another source, it is best practice to paraphrase
the information into your own words, which is the overall expectation when writing an
assignment for an instructor at Confederation College. Paraphrasing ensures writing-style
continuity in your assignment rather than awkwardly inserting a direct quotation with a different
writing style. Paraphrasing taken information also highlights your comprehension of the
information that you are borrowing from the secondary source.

How to Paraphrase Correctly

Read through the source that you are borrowing the information from, and in a bulleted list (1-2
words / item), write down the important points, the most relevant details that you want to
borrow, and the page number(s) that the information is located on. Next, close the original
source that you are borrowing from so that you only have your list in front of you; this will help
to avoid accidentally plagiarizing by creating sentences that are too similar to the original. Write
out the information in your own words, using your own syntactical structures. Replacing
original words with synonyms is plagiarism, not paraphrasing.

How to Create an In-Text Citation for a Paraphrase
Once you have paraphrased the information, you need to create an in-text citation (parenthetical
or narrative) for the paraphrased material.
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Parenthetical In-Text Citation. Type the paraphrased information. Before the end punctuation,
in round brackets (parenthesis), type the author’s surname, the year of publication, and the page
or paragraph number that the taken information is located on. Add end punctuation after the end
bracket of the in-text citation. See Figure 17 for an example.

Figure 17

Paraphrased Parenthetical Example

I Paraphrased Information I

As of May 2, 2020, 49% (578 people) of Ontario residents who have died due to COVID-19
have been residents in long-term care homes (Katawazi, 2020, para. 5).

Parenthetical In-Text Citation: Author’s Surname, Year, Page or Paragraph Number in Parenthesis, Before
End Punctuation

Narrative In-Text Citation. In the signal phrase, input the original source’s publishing date in
round brackets immediately after the last author’s surname to identify that you have paraphrased
the information that follows it from another source. Next, in round brackets immediately after
the paraphrased information, input the page(s) or paragraph(s) number that the taken information
is located on. Add end punctuation after the end bracket of the in-text citation. See Figure 18

for an example.
Figure 18

Paraphrased Narrative Example
I Signal Phrase I | Narrative Citation: Surname

followed by year in parenthesis

|I Paraphrased Information I

Katawazi (2020) noted that as of May 2, 2020, 49% (578 people) of Ontario residents who
have died due to COVID-19 have been residents in long-term care homes (para. 5):

Narrative Citation: Page or Paragraph in
Parenthesis Before the End Punctuation

Direct Quotation

A direct quotation is used when you are using the exact words of another source in your
assignment. Direct quotations should be used sparingly and only when necessary. While it is the
expectation that students paraphrase rather than directly quote a source, there are scenarios that a
direct quotation is more suitable: an exact definition, a complex or concise piece of information,
or when you are writing to something someone has directly stated.
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Some modifications to a direct quotation may be necessary, as per the examples in Table 3. A
common modification that needs to be made in direct quotations occurs when there are already
double quotation marks within the direct quotation. All double quotation marks in the original
source must be changed to single quotation marks. If you need to remove content from the
middle of a direct quote, you must put a pair of ellipsis with three periods between them, which
notifies your reader that you have removed content. If there is a spelling error in the original
source, write out the spelling error, but immediately following the error, insert sic surrounded by
square brackets to indicate that the error was not a typo on your part. 1f you need to insert an
explanation or an addition into a direct quote, surround the addition in square brackets to indicate
to the reader that the addition is not from the original source.

Table 3

Modifying a Direct Quotation

Modification Original Quotation Modified Quotation
(as written in the original
document)

A Quotation | Premier Doug Ford’s stance on the “Premier Doug Ford’s stance on the
Within a matter is clear: “People have to matter is clear: ‘People have to
Quotation practice social distancing. They just practice social distancing. They just

have to. We’ve come all this way. have to. We’ve come all this way.
Why go backwards based on having Why go backwards based on
warm weather?” having warm weather?’” (Crawley
& King, 2020, para. 7).
Remove There has been an increase in the total | “the total number of novel
Content number of novel coronavirus cases in | coronavirus cases in Ontario to
Ontario to 17,119, including 1,176 17,119, including (...) 11,390
deaths and 11,390 recoveries. recoveries” (Katawazi, 2020, para.
2).
Identifying an | As of Saturday, there are 977people in | “As of Saturday, there are

Errorinthe | hospital 977people [sic] in hospital”
Source’s (Katawazi, 2020, para. 12).
Quotation
Inputting As of Saturday, there are 977people in | “As of Saturday [May 2, 2020],

Content hospital there are 977people [sic] in
hospital” (Katawazi, 2020, para.
12).

How to Use a Short Direct Quotation (Fewer than 40 Words) Correctly

You must put double quotation marks around any words that you use from your source. Your
quoted material must be exactly the same as in the original source. Once you have written out
the direct quotation into your paper, you need to create an in-text citation (parenthetical or
narrative) for the quoted information.

27




Figure 19
Embedded, Short, Direct Quotation Example

I Embedded, Short, Direct Quotation I

As of May 2, 2020, Ontario health officials identified an increase in “the total number of novel
coronavirus cases in Ontario to 17,119, including 1,176 deaths and 11,390 recoveries”
(Katawazi, 2020, para. 2).

i Parenthetical In-text Citation I

How to Use a Long Direct Quotation (More than 40 Words) Correctly

Long quotations should not be used unless it is necessary, especially in shorter assignments.
Unlike a short quotation, a quotation of more than 40 words does not have double quotation
marks surrounding it, and it is formatted in a block style. When inputting the long quotation in a
paragraph, ensure that you do not add a space before or after the quotation. Double space the
quotation and indent the entire quotation 0.5 inches (0.5”) from the left margin. If there is more
than one paragraph in the quotation, indent the first line of the second and subsequent
paragraphs.

How to Create an In-Text Citation for a Long Direct Quotation

After the last punctuation mark, create a parenthetical citation in round brackets, and do not put
an end punctuation after the in-text citation. Press enter one time and continue writing the
paragraph flush with the left margin. Please note that a paragraph should never begin with a
long quotation, as shown in Figure 20.
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Figure 20
Long, Direct Quotation Example

I Second Paragraph in Quotation Indented I I Portion of Paragraph Written in the Student’s Words I

On May 2, 2020, The Ontario Government released a summary of COVID-19 data:
Health officials, in the summary, said that of all deceased patients in Ontario, seven were
between/the ages of 20 and 39. They also said that 52 people were between the ages of
40 and 59 and 302 people were between the ages of 60 and 79.

People who are over the age of 80 have been hit the hardest. So far, at least 815

people in this age group have died. (Katawazi, 2020, para. 6-7)¢} No End Punctuation After
In-Text Citation

I Direct Quotation, Block Indented. I

Parenthetical In-Text Citation
After the Final Punctuation.

In-Text Citations

What is an In-Text Citation?

An in-text citation is the second mandatory component of the anti-plagiarism formula, listed in
Figure 12. An in-text citation functions in three ways: it indicates that you have taken
information and are giving credit to the author of the original source; it signals the end of the
taken information; and it also acts as a road map for readers who, if used in conjunction with the
reference entry, can locate your taken information easily within the original source. Please note
that for every in-text citation, you must have a matching reference entry listed in the References
page. As a quick tip, in most cases, the first word in a parenthetical in-text citation will be the
first word of the matching reference entry.

How to Use an In-Text Citation

An in-text citation contains three pieces of information: the author, the date, and the page or
paragraph number. You must include an in-text citation with every sentence that contains a
paraphrase, summary, or quote. Except for in-text citations for summarized information, you
must indicate where, in the original source, the information came from, which is typically written
with a page or paragraph number. If the information has come from more than one page in the
original source, write pp. and then the page range (pp. 4-5) in the in-text citation. If the
information has come from more than one paragraph, write paras. and then the paragraph range
(paras. 34-35) in the in-text citation.
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Parenthetical In-Text Citation

A parenthetical in-text citation has the mandatory information needed to make an in-text citation,
and all of the information is located between two round brackets, immediately following the
taken information, before the end punctuation.

How to Format a Parenthetical In-Text Citation. As shown in Figure 21, as soon as you input
the taken information, you must put the parenthetical in-text citation immediately behind the
information, before the period. If the information that you have taken is paraphrased from more
than one page or paragraph, use pp. # - # or paras. # - # in the in-text citation.

Figure 21

Parenthetical in-text Citation Example
On May 5, 2020, of the 17,119 reported cases of COVID-19 in Ontario, there was a
discrepancy between the province’s reports and the health units’ collective reports of COVID-
19 related deaths. The province’s report stated that there were 1,176 deaths, and the total
from local health units reported a collective total of 1,249 deaths related to COVID-19

(Katawazi, 2020, paras. 25-26).

I Author’s Surname I I Year of Publication I Exact Location within the Source

Narrative In-Text Citation

A narrative in-text citation has the mandatory information needed to make a complete in-text
citation; however, the information is written in the signal phrase before the taken information
and, in most cases, after the taken information, before the end punctuation.

How To Format a Narrative In-Text Citation. As shown in the signal phrase of Figure 22,
identify the author in the written text of your assignment. Immediately after the last surname,
input the publication year between two round brackets. After you write the taken information,
before the final punctuation, insert the page or paragraph number where the taken information is
located in your secondary source.

Figure 22
Narrative In-Text Citation Example

I Author’s Surname II Year of Publication I I End Punctuation I

Katawazi (2020) reported that of the 17,119 cases of coronavirus as of April 5, 2020, 11,390
cases had been confirmed as recovered (para. 2).

I Exact Location within the Source I
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In-text Citation Examples & Guidelines

The following examples demonstrate how to format an in-text citation based on specifications of
the original source. Please note that these are merely common in-text citations and do not cover
all in-text citation scenarios. You can modify the author, date, or location portion of the in-text
citation in accordance to the APA formats listed below. For example, you could combine an
Anonymous author without a publication date in the in-text citation by combining the examples
below: (Anonymous, n.d., p. C3).

In-Text Citation Date Reminder
Even if your source has an exact date, you only list the year in which the source was published
within the in-text citation.

In-Text Citation Location Reminder

If there is a page number, input the page number, represented by p. #, in the in-text citation. If
there is not a page number, input the paragraph #, represented by para. #, in the in-text citation.
If the information is from more than one page or paragraph, input the page or paragraph span the
information is from, represented by pp. #-# or paras. #-#.

Single Author
Use this format if the source you have taken the information from has one author.

(Author’s Surname, Year of Publication, Location Within the Source)

Parenthetical Example: (Katawazi, 2020, para. 25)

Narrative Example: Katawazi (2020) stated ... (para. 25).

Two Authors
Use this format if the source you have taken the information from was written by two authors.

(Surname 1 & Surname 2, Year of Publication, p.#)
Parenthetical Example: (Freeman & Sanders, 2019, p. 45)

Narrative Example: Freeman and Sanders (2019) stated ... (p. 45)

Three to Twenty Authors

Use this format if the source you have taken the information from was written by three or more
authors.

(Surname 1etal., Year of Publication, p.#)
Parenthetical Example: (Bourgeois et al., 2020, para. 7)

Narrative Example: Bourgeois et al. (2020) outlined ... (para. 7)
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Corporate or Group Author without an Abbreviation

Use this format if the source you have taken the information from has a group author or organization
named, but an individual has not been identified as having written the document.

(Organization Name, Year of Publication, p.#)
Parenthetical Example: (Confederation College, 2020, para. 22)

Narrative Example: Confederation College (2020) identified ... (para. 22)

Corporate or Group Author with an Abbreviation

Use this format if the source you have taken the information from has a group author or an
organization that has an official abbreviation. The first in-text citation must have the full name of the
organization listed as the author with the abbreviation listed in square brackets immediately after the
organization’s name. For all subsequent in-text citations, you can use the abbreviation rather than
writing out the entire organization’s name.

First In-Text Citation: (Organization Name [Abbreviation], Year of Publication, p.#)
Subsequent In-Text Citations: (Abbreviation, Year of Publication, p.#)

1%t Parenthetical Example: (Centers for Disease Control and Prevention [CDC], 2020, para. 5)
Subsequent Parenthetical Examples: (CDC, 2020, para. 7)

1t Narrative Example: The Centers for Disease Control and Prevention (CDC, 2020) identified ...
(para. 5)
Subsequent Narrative Example: The CDC (2020) defined ... (para. 7)

No Date

Use this format’s date layout if the source you have taken the information from does not have an
identifiable published date or copyright date.

(Author’s Surname, n.d., p. #)

Parenthetical Example: (Godin, n.d., p. 66)

Narrative Example: Godin (n.d.) stated ... (p. 66).
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Authors with the Same Surname

Use this format if the sources you have taken the information from was written by two, separate
authors with the same surname, with the same or differing publication years.

Author of Source 1: (First Initial. Surname, Year of Publication, p.#)

Author of Source 2: (First Initial. Surname, Year of Publication, p.#)

Parenthetical Example Source 1: (D. Shannon, 2020, p. 74)
Parenthetical Example Source 2: (L. Shannon, 2020, para. 15)

Narrative Example Source 1: D. Shannon (2020) stated ... (p. 75).
Narrative Example Source 2: L. Shannon (2020) claimed ... (.Para. 15)

Multiple Works with Three or More of the Same Authors

Use this format if you have taken information from two (or more) sources that have some of the same
authors listed, which would make your in-text citation identical using the standard “3 + authors”
format. Write out the surname of the authors in the author section until the last surname listed differs
between the two sources, then write et al.

Authors of Source 1: (Same Surname 1, Same Surname 2, Differing Surname et al., Year
of Publication, p.#)
Authors of Source 2: (Same Surname 1, Same Surname 2, Differing Surname et al., Year

of Publication, p.#)

Parenthetical Example Source 1: (Jason, Walker, Anderson, et al., 2019, p. 75)
Parenthetical Example Source 2: (Jason, Walker, Langille, et al., 2019, p. 107)

Narrative Embedded Example Source 1: Jason, Walker, Anderson, et al. (2019) claimed ... (p. 75)
Narrative Embedded Example Source 2: Jason, Walker, Langille, et al., (2019) identified ... (p. 107)

Works with the Same Author and Same Publication Date

Use this format if you have taken information from a source that has the same author and the same
publication date. To decipher between the in-text citations and reference entries, you must assign an
ascending letter behind the date format, which will also correspond with the reference entry date
format. Assign the letters by organizing each source by priority under the following chronological
sections: Year only, specific dates. Remember, the letter format in this in-text citation will look
identical to the matching reference entry.

Source 1: (Surname, Year of Publicationa, p.#)
Source 2: (Sumame, Year of Publicationb, p.#)

Source 3: (Sumame, Year of Publicationc, p.#)

Parenthetical Example Source 1: (McDougall, 20173, p. 75)
Parenthetical Example Source 2: (McDougall, 2017b, p. 7)
Parenthetical Example Source 3: (McDougall, 2017c, p. 104)

Narrative Embedded Example: McDougall (2017b) provided ... (.P-7)




Unknown Author

Use this format if the source you have taken the information from does not have a named author or an
implied author (Group or Corporate author). In this case, the title of the work moves to the author
position in the in-text citation (as well as in the reference entry). The title, no matter the type of source,
must be written in title case in the in-text citation and sentence case in the reference entry. Use key
words to shorten the title if it is long. If the title is italicized in the reference entry (a stand-alone
piece), italicize the title in in the in-text citation. If the title of the source is not italicized in the
reference entry (it is a part of a larger work), put double guotation marks around the title.

Stand-Alone Source with Unknown Author (i.e. book): (Title, Year of Publication, p.#)
(14
Source that is a part of a larger work (i.e. Magazine Article): ( Shortened Article

9
Title, Year of Publication, p.#)

Parenthetical Example - Book with no Author: (Dissecting Grammar of Gen Zs, 2019, p. 3)
Parenthetical Example — Magazine Article with no Author: (“Semicolons versus Colons,” 2020, p.
55).

Narrative Example - Book with no Author: In Dissecting Grammar of Gen Zs (2019), ... (p. 3)
Narrative Example — Magazine Article with no Author: As defined in “Semicolons versus Colons”
(2020), ... (p. 55)

Anonymous Author

Only use this format if the source you have taken the information from specifically states that the
author is written by “Anonymous’.

(Anonymous, Year of Publication, p.#)

Parenthetical Example: (Anonymous, 2019, p. C3)

Narrative Example: Anonymous (2019) stated ... (p. C3).

Specific Parts of a Source — Information from a Graphic/Figure/TabIe/Section/PowerPoint

Use this example if you are borrowing information from a specific part of a text, like information from
a graphic, that you are inputting into the text of your assignment. Please note that this is not to be used
for copying an entire graphic, but only some information from within a graphic to use in the narrative
of your assignment.

(Author’s Surname, Year of Publication, Specific Location Within the Source)

Parenthetical Examples:  (Vaccher, 2019, Table 1)
(Charlton, 2018, Figure 5)
(Langille, 2020, Slide 7)

Narrative Examples: ~ Vaccher (2019) highlighted ... (Table 1)
According to Charlton (2018), ... (Figure 5)
Langille (2020) claimed ... (Slide 7)
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An Entire Graphic/Figure/TabIe

If you have taken or adapted a graphic/figure/table from a source and have input that
graphic/figure/table into your assignment, you will not use an in-text citation, but you will use a
coezright notation in the footnote. Please see the “Graphics” section of this guide.

Dictionary / Encyclopedia Entry

Use this format if you have taken information or a definition form a dictionary or encyclopedia.
Please note that you do not indicated a page or paragraph number in this form of in-text citation.

(Group Author, Year of publication)

Parenthetical Examples: (Oxford University Press, 2020)

Narrative Example: Oxford University Press (2020) defined ...

Legal Court Decisions

Use this format if the information you have taken is from a legal case or a court decision. Please note
that the names of both parties are italicized, and the year listed is the year that the decision was made
on the case in court. If you have taken information from a criminal court case, input the crown in the
first section of the case name and the defendant in the second section of the case name. If you are
borrowing information from a civil court case, input the claimant in the first section of the case name
and the defendant’s name in the second section of the case name.

(Claimant v. Defendant, year decision was made on the case)

Parenthetical Example: (Crete v. Aqua-Drain Sewer Services Inc., 2017)

Narrative Embedded Example: In Crete v. Aqua-Drain Sewer Services Inc., (2017) ...

Translated, Reprinted, Republished Source

Use this format if the information you have taken from the source was previously published in an
original work. You must indicate the author of the work and the original publishing date / current
source’s publishing date.

(Author’s Surname, Year of Original Publication/Y ear of Current Source’s Publication)

Parenthetical Example: (Darwin, 1859/2010)

Narrative Example: Darwin (1859/2010) claimed ....

Ancient Greek or Roman Work(s)

Use this format if the information you have taken is from an ancient Greek or Roman work. You must
indicate the author of the work, the estimated (.ca) original publishing date / current source’s
publishing date, and the specific section of the source.

(Author’s Surname, ca. Year of Original Publication/Year of Current Source’s Publication,

specific section)

Parenthetical Example: (Homer, ca. 800 B.C.E./2009, 18.141)

Narrative Embedded Example: Homer (ca. 800 B.C.E./2009) depicted ... (18.141).
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General Personal Interview / Personal Communications

Use this format if you are using information that you obtained in a personal interview or personal
communication with a person, and that communication can not be accessed by another person (email,
telephone call, etc.). This in-text citation will not have a matching reference entry because it cannot be
retrieved by an outside audience. You need to input the interviewee’s first initial and surname,
followed by the words “personal communication,” and then identify the date the communication took
place using month date, year format.

(Interviewee’s First Initial. Interviewee’s Surname, personal communication, Month date,

year)

Parenthetical Example: (L. Meyers, personal communication, April 30, 2020)

Narrative Embedded Example: L. Meyers stated ... (personal communication, April 30, 2020)

Primary Research Participant Interview

You do not use an APA in-text citation when using information in your paper that was gathered from
an interview with a research participant.

Personal Interview/ Personal Communications with an Indigenous Person

Use this format if you are using information that you learned in a personal interview or personal
communication with an Indigenous person. The interviewee must give consent to having his/her/their
name printed in an academic paper. Please note that if you are retelling an Oral Tradition/History
obtained in a personal communication, you must receive consent to use the information in your paper.
In the in-text citation, you need to input the interviewee’s full name and the nation or Indigenous
group they belong to, their location, followed by “personal communication,” and the date in the month
date, year format.

(Indigenous interviewee’s full name, nation or Indigenous group, interviewee’s location,

personal communication, Month date, year)

Parenthetical Example: (Maddy Skye, Migisi Sahgaigan, Dryden, Ontario, Canada, personal
communication, March 22, 2019)

Narrative Embedded Example: Maddy Skye identified ... (Migisi Sahgaigan, Dryden, Ontario,
Canada, personal communication, March 22, 2020)

Film /DVD

Use this format if the information you have taken is from a standalone film or DVD. In the author’s
position, input the director’s name. If the director’s name is not listed or credited, input the executive
producer’s name.

(Director’s Surname, Year of release date, Time Information was Presented in Hour: Minute:

Second format)

Parenthetical Example: (Cooper, 2018, 01:20:21)

Narrative Embedded Example: Cooper (2018) ... (01:20:21)
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TED Talk

Use this format if you have taken information from a TED Talk video.

(Speaker’s Surname, Year of publication, Time Information Was Presented in Hour:

Minute: Second format)

Parenthetical Examples: (Nott, 2019, 0:25:12)

Narrative Embedded Example: Nott (2019) discussed ... (0:25:12)

YouTube Video

Use this format if you have taken information from a YouTube video. Please note that the person who
uploaded the video is credited as the author, even if that person is not the original creator of the video.
If you know the Author’s surname, input the surname in the author position. If you do not know the
author’s surname, input the YouTube username in the author position.

(YouTube Account Holder’s Surname, Year of Upload, Time Information Was Presented

in Hour: Minute: Second format)

Parenthetical Example: (Bruce, 2017, 0:05:22)

Narrative Embedded Example: Bruce (2017) outlined ... (0:05:22)

Podcast Episode

Use this format if you have taken information from a podcast.

(Podcast Host’s Surname, Year of publication, Time Information Was Presented in Hour:

Minute: Second format)

Parenthetical Example: (Murie, 2020, 1:10:36)

Narrative Embedded Example: Murie (2020) defined ... (1:10:36)
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References

What is a Reference Entry?

A reference entry works, in conjunction with an in-text citation, to show the reader exactly where
to get the source’s document that you have taken information from. A reference entry is
mandatory for any taken information, as this is a way that you are academically giving credit to
the author for his/her/their ideas and research.

If you have an in-text citation but are missing a reference entry, or vice versa, your assignment is
deemed plagiarized. Always check to ensure the first surname or first key word listed in a
reference entry has a matching in-text citation using that same surname or key word within the
body of the assignment. The reference entries are formatted in a specific way on the References
page: see section “APA Assignment Format” for formatting instructions.

What Information Does a Reference Entry Contain?

The information given in a reference entry will differ, depending on the type of source the taken
information has come from. However, you can pretty much assume that the following
information will be required in any reference entry (plus or minus some details depending on the
source type):

First Name’s Inital and Last Name of Each Author

Title of the Article

Title of the Standalone Book

Title of a Periodical

Specific Date

Publisher’s Name

Page Range (for an article)

URL

ONoGa~wWNE

General Guidelines When Finding and Formatting Reference Entry Components
Please see the following tips surrounding compiling and formatting components in a reference
entry.

Table 4
Quick Reference Guidelines
Tip / Guideline | Example
Author’s Name
An author’s name, unless otherwise stated, is Andersen, J.

always written in the following format within the
reference entry: Surname, 1% initial of first name.

Never include an author’s position or rank within | Dr. Mark Long = Long, M.
the reference entry. For example, you would
remove “Dr.” before inputting a doctor’s name
into the reference entry.
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Tip / Guideline (Cont’d)

| Example Cont’d

Author’s Name Cont’d

If you are not sure which name is the author’s first
name and which is the author’s last name, use the
following guidelines:

1. Chris Jason: If there is no comma separating
the name, the first name listed is the first name
and the second name listed is the surname.

2. Jason, Chris: If there is a comma separating the
name, the first name listed is the surname and
the second name listed is the first name.

3. If you cannot decipher the difference between
the first and last name, research another
published work by the same author to decipher
the difference between first and last name.

1st Name Surname

1. Chris Jason

st
Surname 1* Name

2. Jason, Chris

If the author’s surname is two words or if it is
hyphenated, write the name as it appears in the
source.

Krista Sanders-Freeman =
Sanders-Freeman, K.

Nicole Robinson Stein =
Robinson Stein, N.

If you have two authors, separate the authors using
“’ &”‘

Nicholl, L., & Bourgeois N.

If you have three to twenty authors, separate the
authors using a comma, and after the second last
listed author, insert a comma and a &.

Nicholl, L., Bourgeois, N., Shannon, D., &
Cooke, C.

If the author is a group or organization, do not
reverse the wording. State the group author’s
name as it appears on its publication document.

Confederation College

If there is no known author, and the author has not
represented him/her/themselves by using the name
“Anonymous,” input the title of the source in
author’s position in the reference entry.

COVID-19 Update

Date

For a book or stand-alone source, use the
copyright year as the date in the reference entry.
This information should be found on the copyright
page of the document.

©2020 = (2020)

When an exact date is given and required, use the
year, month date format.

(2020, May 5)
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Tip / Guideline (Cont’d)

Example Cont’d

Date Cont’d

If only the year and month is given, use the year,
month date format.

If a combined month publication is given, use the
year, month / month format.

(2020, May)
(2020, May/June)

If the source is published by season or by month,
use the year, season or year, month format.

(2020, Spring)
(2020, March)

If the source does not have a publication date,
input n.d. into the date component of the reference
entry.

(n.d.)

Title

Whether you are writing the title of an article or a
stand-alone source, write the title in sentence case.

Stand-alone source: Cites and sources
Article: Liberals are spending a fortune

URL

The URL in a reference entry must be an active
link (your reader should be able to click on it), and
it must be in good working order. You must
always click on the URL to ensure that it will
bring your reader straight to the source that you
have taken the information from.

If the webpage is continually updated, and the
webpage that you have provided the link to could
have changed in content, provide a retrieval date
statement (Retrieved Month Date, Year, from)
before the URL.

https://www.cbhc.ca/news/politics/agri-food-

covid-liberals-1.5555591

... Retrieved May 5, 2020, from
https://www.cbc.ca/news/canada/coronavirus-

covid19-may6-canada-world-1.5557336
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Tip / Guideline (Cont’d) \

Example Cont’d

Digital Object Indentifier (DOI)

A DOl is the best standard for providing a digital
retrieval URL than using a “Permalink” URL. If
you are given the option to use a DOI link, which
will be listed on the “Overview” page of the
source, use it over the URL in the reference entry.
Double check to ensure that the DOI links directly
to the source that you have taken your information
from.

A Gkt

—

% e Public Heatth Responses to COVID-19 Outbreaks on Cruise Ships - Worldwide, February-March 2020.

.

Missing Volume Num

ber or Issue Number

If the source that you are referencing is missing a
volume or issue number, then only state the
information that is provided in your reference
entry. If the volume and issue numbers are both
missing, then you cannot provide either in your
reference entry.

..Journal Title, 6, 44-77.

I Missing (Omitted) Volume I
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How to Format the References Page

An APA references page has mandatory formatting, which requires attention to detail. Follow
the short instructions in Figure 24 or the long instructions in Figure 25 to properly format your
References page. If your References page does not have identical formatting to the example in
Figure 23, you have made a mistake.

Figure 23
APA References Page Example

References
Hughes, N., & Schwab, I. (Eds). (2010). Teaching adult literacy: Principles and practice. Open
University Press.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=nlebk & AN=466496&site=eds-live&scope=site

Robinson, S. A. (2018, April). A study designed to increase the literacy skills of incarcerated
adults. Journal of Correctional Education, 69(1), 60-72.
https://ra.ocls.ca/ra/login.aspx ?inst=confederation&url=http://search.ebscohost.com/login
.aspx?direct=true&db=eric& AN=EJ 118521 1 &site=eds-live&scope=site

Kociety for the Scientific Study of Reading. (2002). Reading development in adults: A special
issues of scientific studies of reading. Routledge.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=nlebk& AN=90942 &site=eds-live&scope=site

Stuart-Smith, V. (2003, June). Using functional grammar to teach academic literacy skills to
adults with language-related learning difficulties. Australian Journal of Language and
Literacy, 26(2), 69-81.

https://ra.ocls.ca/ra/login.aspx ?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=edsind&AN=edsind. 14649497604 6844 &site=eds-live&scope=site




Format Instructions for the References Page

Figure 24

APA References Page: Short Instructions

Refe.rence ) Reference entries are Title is centred, written in bold font,
entries are listed double spaced and have on the first line of the References
n dalphabet|cal hanging indents. page. One double space between
order title and first reference entry.
References
g

Hughes, N., & Sehiwab, I. (Eds). (2010). Teaching adult literacy: Principles and practice. Open

niversity Press.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=nlebk & AN=466496 &site=eds-live&scope=site

Robinson, S. A. (2018, April). A study designed to increase the literacy skills of incarcerated

adults. Journal of Correctional Education, 69(1), 60-72.
https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=eric& AN=EJ 118521 1 &site=eds-live&scope=site

==, Rociety for the Scientific Study of Reading. (2002). Reading development in adults: A special

issues of scientific studies of reading. Routledge.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=nlebk & AN=90942 &site=eds-live&scope=site

Stuart-Smith, V. (2003, June). Using functional grammar to teach academic literacy skills to

adults with language-related learning difficulties. dustralian Journal of Language and
Literacy, 26(2), 69-81.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login

.aspx?direct=true&db=edsind&AN=edsind. 14649497604 6844 &site=eds-live&scope=site
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Figure 25
How to Format an APA References Page in Microsoft Word: Long Instructions

Step What it Looks Like in Microsoft Word
1. Start your APA X

References page On the - Home “ Layout References Mailings Review View Help
firstblank page atter the || o e e e ol |

last paragraph of your —
assignment. Place your
cursor on the first line of
the new page.
A) Click the “Home” tab
B) Click the “No
Spacing” button
C) Click the “Line
Spacing” button
D) Click the “2.0” button
from the drop-down
menu

tyles

ings Review  View

2. Place your cursor on the

I
flrSt Iine Of the page. r_\‘u Times New Ror ~ ! i =T EE Gl T sasbeondee | asbeande | AaBLCeD( Acsbcende A B
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button

C) Click the “Centre” E .
button ‘ ﬂ HB

D) Capitalize the word
“References” on the
first line of the
document
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Step (Cont’d)

3. From the title line, press
the “Enter” key on your
keyboard one time.

A) Click the “Home” tab
B) Click the “Bold”

button to remove the
bold font

C) Click the “Left Align”

button

4. Using your APA guide,
type out your properly
formatted reference
entries.

*Press the “Enter” key on

your keyboard at the end of

each reference entry and
begin the next reference
entry on the next line. Do
not insert extra line spaces
between the reference
entries*

What it Looks Like in Microsoft Word (Cont’d)

Review View Help

Robinson, S. A. (2018, April). A study designed to increase the literacy skills of incarcerated
adults. Journal of Correctional Education, 69(1), 60-72.
https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login.aspx?d
irect=true&db=eric& AN=ET118521 1 &site=eds-live&scope=site

Hughes, N., & Schwab, I. (Eds). (2010). Teaching adult literacy: Principles and practice. Open
University Press.
https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login.aspx?d
irect=true&db=nlebk & AN=466496&site=eds-live&scope=site

Society for the Scientific Study of Reading. (2002). Reading development in adults: A special
issues of scientific studies of reading. Routledge.
https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login.aspx?d

irect=true&db=nlebk & AN=90942 &site=eds-live&scope=site

Stuart-Smith, V. (2003, June). Using functional grammar to teach academic literacy skills to
adults with language-related learning difficulties. Australian Journal of Language and Literacy, |
26(2), 69-81.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/login.aspx?d

irect=true&db=edsind& AN=edsind. 146494976046844 &site=eds-live&scope=site
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Step (Cont’d)

A)

Once you have typed out
all of your reference
entries, you now need to
place your reference
entries in alphabetical
order.

Highlight all of the

reference entries,
excluding the title line

B) Press the “Home” tab

C) Press the “Sort Text”
button

D) In the “A-Z Sort Text”
pop up window, click
Sort By “Paragraph” in
“Ascending” order

E) Press the “OK” button

6. Now add a hanging
indent for each entry.
A) Highlight all of the
reference entries,
excluding the title line

B) Press the “Home” tab

C) Press the S button
within the
“Paragraph” toolbar
In the “Paragraph”
pop up window, click
the “Special” drop-
down menu and select
“Hanging” by 1.27
cm
Click the “OK”
button
F) Check to ensure all
URL links work

D)

E)

Home Insert Draw

o) | 9~ =

Design

gs New Ror ~|12

Draw Design Layout

Layout
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What it Looks Like in Microsoft Word (Cont’d)
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Step (Cont’d) |

What it Looks Like in Microsoft Word (Cont’d)

PLAGIARISM CHECK: VERY IMPORTANT

Your last step is to
double check to ensure
that all of your reference
entries have matching in-
text citations. The
easiest way to do this is
to search by the first
surname or keyword of
each reference entry.
A) Press the “Home” tab
B) Press the “Find”
button under the
“Editing” toolbar, and
then press the “Find”
button from the drop-
down list
Under the pop-up
“Navigation”
window, type in the
surname of the author
from your first
reference entry.

C)

£ Share
[}

Forind v
£ find

F

ditor

AaBbCcDdEe  Aabbcdte A3 n
ac.. Hea Tit £l
A+ Bdvanced Find
Syl 5

Cipboard M3 Font ditoe
¢ . ? GoTe. '

Navigation

Headings  Pages  Results

Use the search bax for text or the magnifying
qlass for everything ele.

[ Comments

Once you have typed
the first author’s
surname into the
“Navigation” search
bar, you should see at
least two results:

A) the in-text citation
you used within
your document

B) the reference entry
from your
References page

*Repeat this step for

every reference entry in

your list*

Navigation

%

Hughes
2results

Headings

continues. Paragraph content continues,
Hughes and Schwab (2010) claim
teaching adult

Hughes, M., & Schwab, |. (Eds). (2010)
Teaching adult literacy: Pring Ip\r and

practice. Open

f incarcerated

Robinsoa, 5. A. (J018, Apeil). A study designed to increase the literacy skills o

PLAGIARISM TRIPLE CHECK!

If you have not found an in-text citation for each reference entry, you have made a critical mistake and must do one of the

following:
A)

input the missing in-text citation

B) double check to ensure you have a properly formatted each in-text citation for each reference entry
Once you have confirmed you have at least one in-text citation for each reference entry, your references page is
complete. The format should look identical to the References page in Figure 9.
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Reference Examples & Guidelines
Use this section to mimic the format of the reference entry by the type of source that you have
taken information from. If you do not see your type of source on the list, consult the APA
Manual: American Psychological Association. (2020). Publication manual of the American
Psychological Association (7" ed.). https//doi.org/10.1037/0000165-000

Journals

Article with One Author — Basic Format

If you have taken information from an article by one author that was published in a periodical
(peer-reviewed journal), use this format to create the reference entry.

Title of the
periodical is
italicized,
written in title
case

Input the date as per the noted year/month or
year/season of the publication. Refer to the “Tips and
Tricks” section for multiple ways to format a date.

The title of the article is written
in sentence case, no italics.

Title of the Periodical, Volume #(Issue Number) y, Page range # ~ #.

Author’s Surname, Author’s 1% Initial. (Year, Month/Issue format). Title of the article.

DOl or URL

The volume number is written
as a numeral only and is
written in italics. If thereis an
issue number, place it in
round brackets immediately
after the volume number.

The page range is
written as numerals
only, and this portion
lists the first page
number of the article
and the last page of the
article, separated by
one hyphen.

Input DOI for all
publications. If
there is not a DOI,
insert the entire URL
for online
publications.

Example:

Leydet, D. (2019, Summer). The power to consent: Indigenous peoples, states, and
development projects. University of Toronto Law Journal, 69(3), 371-403.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=rch&AN=136789668&site=eds-live&scope=site
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Article with Two Authors

If you have taken information from an article by two authors that was published in a periodical
(peer-reviewed journal), use this format to create the reference entry.

Input the author’s names as they are listed on the overview sheet of the article. Separate the two authors using “, &”. The rest of the
format is identical to that of an “article with one author”.

First Author’s Surname, First Author’s 1% Initial. , &. Second Author’s Surname, Second

Author’s 1% Initial. (Year, Month/Issue format) . Title of the article. Title of the

Periodical, Volume #(Issue Number) y page range # = #. DOI or URL

Example:

Mayor, C., & Suarez, E. B. (2019, Spring). A scoping review of the demographic and

contextual factors in Canada’s educational opportunity gaps. Canadian Journal of

Education, 42(1), 42-87.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=eric&AN=EJ1210293&site=eds-live&scope=site
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Article with Three to Twenty Authors

If you have taken information from an article written by three to twenty authors, you must list
all of the authors’ names in the reference entry. Separate each author in the reference entry by
using a comma, and insert a “, & to separate the second last and last author. Please see the
in-text citation Example for “three to twenty authors” to properly format the in-text citation
for this type of reference entry.

List the authors as they are presented on the overview page of the article. Separate all authors in the list with a comma and
continue the “Surname, 1%t initial.,” format until the last author. Separate the 2" last and last authors with “, &”. The rest of the
format is identical to that of an article with one author. If you have a document listed with 20 authors, all 20 authors must be
listed in this section of the reference entry.

First Author’s Surname, First Author’s 1% Initial., Second Author’s Surname, Second
Author’s 1% Initial . , & Last Author’s Surname, Last Author’s 1% Initial. (Year,

Month/Issue format) . Title of the article. Title of the Periodical, Volume #(Issue

Number) y page range # ~ #. DOl or URL

Example:

Anthes, R. A., Maier, M. W., Ackerman, S., Atlas, R., Callahan, L. W., Dittberner, G.,
Edwing, R., Emch, P. G., Ford, M., Gail, W. B., Goldberg, M., Goodman, S.,
Kummerow, C., Onsager, T., Schrab, K., Velden, C., Vonderhaar, T., & Yoe, J. G.
(2019, September). Developing priority observational requirements from space using
multi-attribute utility theory. Bulletin of the American Meteorological Society, 100(9),

1753-1774. http://dx.doi.org/10.1175/BAMS-D-18-0180.1
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Article from a Special Issue of a Journal

If you have taken information from an article that was published in a special issue of a
periodical (peer-reviewed journal), use this format to create the reference entry.

Author’s Surname, Author’s 1% Initial. (Year, Month/Issue format). Title of the article

[Special issue]. Title of the Periodical, Volume #(Issue Number) y page range # = #. DOI
or URL

Immediately after the title of article,
write a description, in sentence case, of
the special identifier in square brackets.
The rest of the format follows “Article by
one author” example.

Example:
Dong, B., Zhu, Y., Xu, Z., Zhang, R., & Yi, G. (2019). Pollution characteristics and risk
levels of the chemical toxin mirocystin on coastal areas [Special section]. Journal of

Coastal Research, 94(1), 87-90. http://dx.doi.org/10.2112/S194-016.1

Books
Online Book — Basic Format (EBook)

If you have taken information from an EBook, you must include the DOI or URL that links
directly to the online copy of the book at the end of the reference entry. You can add the URL
or DOI to the end of any “Book” Example formats listed below.

Italicize Title
Author’s Surname, 1% Initial . (Copyright Year) . L!UHH!UUUJ Publisher’s Name.

DOl or URL

Example:
Call, N. & Featherstone, S. (2010). The thinking child. Continuum International Publishing

Group. https://ebookcentral-proquest-com.eztest.ocls.ca/lib/confederation-

ebooks/detail.action?doclD=601534
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Book by One Author (hardcopy)

If you have taken information from a hardcopy book by one author, use the format below to

format your reference entry.
I Italicize Title I

Author’s Surname, 1% Initial. (Copyright Year) . Title of the book. Publisher’s Name.

Example:
Tanaka, M. T. D. (2016). Learning & teaching together: Weaving Indigenous ways of

knowing into education. UBC Press.

Book by Two or More Authors

If you have taken information from a hardcopy book by two or more authors, use the format
below to format your reference entry.

I Separate authors with “comma” and a “&” I

1%t Author’s Surname, 1% Initial. & 2" Author’s Surname, 1% Initial. (Copyright

Year) . Title of the book. Publisher’s Name.

Example:
Motley, J. B., & Randall, A. R. (2009). Early education. Nova Science Publisher Inc..

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=nlebk&AN=281154&site=eds-live&scope=site

I Added URL for eBook I
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Book with an Author and a Named Editor

If you have taken information from a hardcopy book by one author with a named editor on the
cover, use the format below to format your reference entry.

Author’s Surname, 1% Initial. (Copyright Year) . Title of the book (Editor’s 18 Initial.

Editor’s Surname, Ed.) . Publisher’s Name.

I “Ed.” is required because it means editor. For more than one editor, use “Eds.” for editors. I

Example:

Meadows, D. H. (2008). Thinking in systems: A primer (D. Wright, Ed.). Chelsea Green
Publishing.®

Book with an Editor(s) and Without a Named Author

If you have taken information from a book with a named editor on the cover but without a
named author, use the format below to format your reference entry.

Place the editor’s name in the author’s spot of the entry. After the first initial, write (Ed.) to identify the person is an editor, not an

author. If there is more than one editor, list the editors by surname and first initial, and input (Eds.) after the last editor’s first initial to
indicate they are all editors.

Editor’s Surname, 1% Initial. (Ed.). (Copyright Year) . Title of the book. Publisher’s

Name.

Example:

Hindmarch, S., Orsini, M., & Gagnon, M. (Eds.). (2018). Seeing red: HIV/AIDS and public

icy i iversi Added URL for eBook
policy in Canada. University of Toronto Press. I ec TR foreSoo I

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=nlebk&AN=1809913&site=eds-live&scope=site

3 (APA, 2020, p. 322)
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Book that has been Translated

If you have taken information from a book by one author with a named translator on the cover,
use the format below to format your reference entry.

Author’s Surname, 1% Initial. (Copyright Year) . Title of the book (Translator’s 1%t Initial .

Translator’s Surname, Trans.) . Publisher’s Name.

I Trans. Is required because it means translator. I

Example:
Kanape Fontaine, N. (2016). Assi Manifesto (H. Scott, Trans.). Mawenzi House Publishers

Ltd. I Added URL for eBook I

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=nlebk&AN=1590504 &site=eds-

live&scope=site&ebv=EB &ppid=pp iii
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Book within a Series of Volumes

If you have taken information from a book within a multivolume collection, use the format
below to create your reference entry.

Place the volume editor(s)’s name in the author’s spot of the entry. After the first initial, write (Ed.) to identify the person is an editor,

not an author. If there are more than one editor, list them in the same format as 3 + Authors and input (Eds.) to indicate they are all
editors.

I Italicize Series’ Title followed by a colon I

Editor’s Surname, 1% Initial. (Ed.). (Copyright Year). Series title. Vol.#. Volume title.

Publisher’s Name.

I Input volume # *Vol. #.* then italicize the volume’s title. I

Example:

Rickly, J. M., & Vidon, E. S. (Eds.). (2018). Tourism social science series: Vol. 24.

Authenticity & tourism: Materialities, perceptions, experiences. Emerald Publishing

Ltd. Added URL for eBook I

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=nlebk&AN=1717716&site=eds-

live&scope=site&ebv=EB &ppid=pp iv

Book with an Edition #

If you have taken information from a hardcopy book with an edition number listed on the
front cover, use the format below to format your reference entry.

Author’s Surname, 1% Initial. (Copyright Year) . Title of the book (# ed.) . Publisher’s

Name.

I Use ordinal formatting (1%, 2"9, 39) when indicating the edition number. Follow this by ed., which means edition. I

Example:

Meyers, C. (2017). Communicating for results: A Canadian student’s guide (4" ed.). Oxford

University Press Canada.
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Specific Chapter or Article from an Edited Book

If you have taken information from a book within a multivolume collection, use the format
below to create your reference entry.

The word “In” must
I Title of chapter, written in title case, regular font I precede editor’s first initial

Author’s Surname, Author’s 1% Initial. (Copyright Year). Title oy chapter. In Editor’s 1%

Initial. Editor’s Surname (Ed.), Title of book,(pp. #-#). Publisher’s Name.

I Page span of the first to the last page of the chapter, written numerically I

Example:
Sunderland, M. (2016). Crying & separations. In M. Burley (Ed.), The science of parenting:
How today’s brain research can help you raise happy, emotionally balanced children

(2" ed., pp. 34-63). Penguin Random House.
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Works with the Same Author and Same Publication Date

If you have taken information from two or more sources that have the same author and the
same publication year, use this date format in combination with the correct reference entry
format for the type of source you are referencing. Also see “Works with the Same Author and

Same Publication Date” in-text citation example.

Put the reference entries in alphabetical order. Assign each reference entry a letter based on its chronological appearance in the
reference page. Place the letter immediately behind the year in the date component of the reference entry. Do this for each

reference entry with the same author and year of publication.

Source 1: Author’s Surname, Author’s 1% Initial."(Copyright Yeara). Title of article. Title of

Source. URL I Assign the first entry an “a”, the second entry a “b”, and so on. I

Source 2: Author’s Surname, Author’s 1% Initial. (Copyright Yearb). Title of article. Title of

Source. Publisher’s Name.

Example:
Wells, P. (2020a, April 6). Can the forces of globalization ever hope to outlast the

coronavirus?. Macleans. https://www.macleans.ca/politics/worldpolitics/can-the-

forces-of-globalization-ever-hope-to-beat-the-coronavirus/

Wells, P. (2020b, April 7). Quebec’s coronavirus infection outlook: Short-term pain.

Macleans. https://www.macleans.ca/politics/quebecs-infection-outlook-short-term-

pain/
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Ancient Greek or Roman work

If you have taken information from an ancient Greek or Roman work, you have not taken that
information from the original source, but you have taken it from a reprinted, translated
version. Therefore, your reference entry must include the original author’s name as well as
the publishing information of the new work. Please see the in-text citation for “Ancient Greek
or Roman work” for a matching in-text citation format.

Title of the work the
author wrote.

goes by one name, list the one name.

‘l Author of the original work. If the author only I

Author’s Surname, 1% Initial. (Copyright Year Reprinted Book) . Title of the original work

(Translator’s 1*! Initial . Translator’s Surname, Trans.) . Title of Republished Source.

URL (Original work published ca. year) | \dentify the translator with |

Trans. after the name.

Use ca., which means estimated, to identify the
estimated, original published year.

Example:
Homer. (2009). The Iliad (S. Butler, Trans.). The Internet Classics Archive.

http://classics.mit.edu/Homer/iliad.18.xviii.html (Original work published ca. 800

B.C.E)
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Magazines
Online Magazine Article with One Author — Basic Format

If you have taken information from an article by one author that was published in a magazine,
use this format to create

Input the date as per the noted year/month, year/season, or
year/month/date of the publication. Refer to the “Tips and
Tricks” section for multiple ways to format a date.

The title of the article is written
in sentence case, no italics.

Author’s Surname, Author’s 1% Initial. (Year, Month/Issue format). Title of the article.

Title of the Magazine, Volume #(Issue Number) y page range # = #. DOI or URL

Use italics and The volume number is written as a numeral only and The page range is written as numerals
title case is written in italics. If there is an issue number, place only, and this portion lists the first and
capitalization it in round brackets right after the volume number. last page numbers of the article, and
for the title of Do not use italics for the issue number. If there is no the numbers are separated by a
the magazine. volume or issue number, put the page range after the hyphen.

comma behind the magazine title.

Example:
Alter, C. (2020, April 20). A shift with Medic 61. Time, 195(14), 36-39.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=fth& AN=142644688&site=eds-live&scope=site
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Online Magazine Article with Two Authors

If you have taken information from an article by two authors that was published in a
magazine, use this format to create the reference entry.

Input the author’s names as they are listed on the overview sheet of the article. Separate the two authors using “, &”. The rest of the
format is identical to that of an article with one author.

First Author’s Surname, First Author’s 1% Initial. , &. Second Author’s Surname, Second

Author’s 1% Initial. (Year, Month/Issue format) . Title of the article. Title of the

Magazine, Volume #(Issue Number) y page range # = #. DOl or URL

Example:

Taylor-Vaisey, N., & Markusoff, J. (2020, April). 444 Days. Macleans, 133(3), 26-31.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=fth& AN=142058982&site=eds-live&scope=site
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Online Magazine Article with Three to Twenty Authors

If you have taken information from an article written by three to twenty authors, you must list
all of the authors’ names in the reference entry. Separate each author in the reference entry by
using a comma, and insert a “, &” to separate the second last and last author. Please see the
in-text citation Example for “three to twenty authors” to properly format the in-text citation
for this type of reference entry.

List the authors as they are presented on the overview page of the article. Separate all authors in the list with a comma and
continue the “Surname, 1%t initial.,” format until the last author. Separate the 2" last and last author with “, &”. The rest of the
format is identical to that of an “article with one author”. If you have a document listed with 20 authors, all 20 authors must be
listed in this section of the reference entry.

First Author’s Surname, First Author’s 1% Initial., Second Author’s Surname, Second
Author’s 1% Initial . , & Last Author’s Surname, Last Author’s 1% Initial. (Year,
Month/Issue format) . Title of the article. Title of Magazine, Volume #(Issue Number) y

page range # ~ #. DOI or URL

Example:
Hutchins, A., Smith, M-D., Markusoff, J., Taylor-Vaisey, N., Gonzales, C., Mitchell, A., &
Nath, I. (2020, May). Quarantine nation. Macleans, 133(4), 12-29.

https://ra.ocls.ca/ra/login.aspx?inst=confederation&url=http://search.ebscohost.com/lo

gin.aspx?direct=true&db=fth& AN=142571717 &site=eds-live&scope=site
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Magazine Article with an Unknown Author

If you have taken information from an article that was published in a magazine that does not
have an author, use this format to create the reference entry. Please see the in-text citation
example, “Unknown Author” to properly format a matching in-text citation for this type of

reference entry.

Input the title of the article, written in sentence case, in what is typically the author’s position in the entry. Write the word “In” in
regular text immediately before the name of the magazine. The rest of the reference entry should follow the same format as the

“magazine article with one author” format.

Title of the article. (Year, Month/Issue format) . In Title of the Magazine, Volume #(Issue

Number) y page range # = #. DOl or URL

Example:
Discipline hearings. (2020, March). In Professionally Speaking, 55-59.

https://www.oct.ca/publications/professionally speaking/2020-03/2020-03-table-of-

Note: this example’s magazine, Professionally Speaking, does not have volume or issue
ContentS-PS.aSp numbers, so that information is omitted from the reference entry.
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News Publications
Article in a Newspaper

If you have taken information from an article in a printed newspaper, use this format to create
the reference entry.

Input the date as per the noted year/month/date of the publication.
Refer to the “Tips and Tricks” section for multiple ways to format a date.

The title of the article is written
in sentence case, no italics.

Author’s Surname, Author’s 1% Initial. (Year, Month Date) +[Title of the article. Title of

the Newspaper, page #.

Title of the The page number that the
neéwspaper is article is located on is written
italicized,

as an alphanumeric or

written in title numeral only.

case.

OR

Author’s Surname, Author’s 1% Initial. (Year, Month Date) . Title of the article. Title of

the Newspaper.,K URL,

If the article is from an online
newspaper, input the URL
instead of a page number.

Example:

If there are double quotation marks used in a title,
replace them with single quotation marks.

Mascoll, P., & Rankin, J. (2005, March 31). The day black police officers told Toronto’s
police chief: ‘Racial profiling exists’. Toronto Star, A20.
Shapiro, E. (2020, September 21). Finally, some students will return to New York city’s

classrooms. New York Times. https://www.nytimes.com/2020/09/21/nyregion/prek-

school-reopening-

nyc.html?action=click&module=Top%20Stories&patype=Homepage
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Article in a Newspaper with No Mentioned Author

If you have taken information from an article that was published in a newspaper that does not
have an author, use this format to create the reference entry. Please see the in-text citation
example “Unknown Author” to properly format a matching in-text citation for this type of
reference entry.

Input the title of the article, written in sentence case, in what is typically the author’s position in the entry. Write the word “In” in
regular text immediately before the name of the magazine. The rest of the reference entry should follow the same format as the
“newspaper article in a printed newspaper” format or the “article from a news website” format.

Title of the article. (Year, Month Date) . In Title of the Newspaper, page #.

Example:

SIJHL Players head off to college. (2020, April 17). In The Chronicle Journal, B-01.
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Article from a News Website

If you have taken information from an article/webpage from an online news website, use this
format to create the reference entry. Please note that if the webpage/article is continually

updated, you need to input a retrieval date statement before the URL.

Input the date as per the noted year/month/date of the publication. If The title of the article is written
there are two dates listed, use the “Last Updated” date. Refer to the in sentence case.
“Tips and Tricks” section for multiple ways to format a date.

Author’s Surname, Author’s 1% Initial. (Year, Month Date) . Title of the article. Title of

the News Website.y URL

Title of the If the article or webpage on a news
news website, website is constantly updating, input a
italic font. retrieval statement before the URL:

Retrieved Month Date, Year, from URL.

Individual Author Example 1:
Evans, P. (2020, May 6). Shopify surges to within $1B of Royal Bank for title of most valuable

company in Canada. CBC. https://www.cbc.ca/news/business/shopify-earnings-

1.5557473

Group Author Example 2:

CBC News Staff. (2020, May 6). Coronavirus: What’s happening in Canada and around the
world. CBC News. Retrieved May 6, 2020, from

https://www.cbc.ca/news/canada/coronavirus-covid19-may6-canada-world-1.5557336
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Government and Corporate Documents
Article/webpage on a Government / Government Agency / Organization Website

If you have taken information from an article/webpage from a government’s website, use this
format to create the reference entry. Please note that if the webpage/article is continually
updated, you need to input a retrieval date statement before the URL.

The title of the
article is written in
sentence case,
italics.

are two dates listed, use the “Last Updated” date. Refer to the “Tips and Tricks”
section for multiple ways to format a date.

Input the date as per the noted year/month/date of the publication. If there ‘ ‘

Author’s Surname, Author’s 1% Initial OR Group Author. (Year, Month Date). Title of

the work. Publisher’s Name. URL

Typically, this will be the same If the article or webpage is constantly
as the group author, and updating, input a retrieval statement
therefore, will not be before the URL: Retrieved Month Date,
incorporated into a reference Year, from URL.

entry with a group author.

Group Author Example 1:
Government of Canada. (2020, March 13). Government of Canada takes action on COVID-

19. Retrieved May 6, 2020, from https://www.canada.ca/en/public-

health/services/diseases/2019-novel-coronavirus-infection/canadas-reponse/government-

canada-takes-action-covid-19.html

Individual Author(s) Example 2:

Statistics Canada. Retrieved May 6, 2020, from

https://www150.statcan.gc.ca/n1/pub/45-28-0001/2020001/article/00010-eng.htm

Messacar, D., & Morissette, R. (2020, May 6). Work interruptions and financial vulnerability.
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Report by Government Agency or Other Organization

If you have taken information from a report from a government agency’s website or an
organization’s website, use this format to create the reference entry.

Input the date as per the noted year/month/date of the publication. The title of the report is written in sentence
Refer to the “Tips and Tricks” section for multiple ways to format a case, italics. If needed, use a description of the
date. document [Report #] in square brackets,

immediately after the last word of the title.

Group Author OR Organization’s Name. (Year, Month Date) . Title of the report

[Description]. ,Publisher’s Name. URL

Typically, this will be the same
as the group author, and
therefore, will not be
incorporated into a reference
entry with a group author.

Example:
Children’s Aid Society of Toronto. (2019). Building bridges, brightening lives [Annual

Report]. https://www.torontocas.ca/sites/torontocas/files/CAST_Annual_2018 EN.pdf
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Brochure by a Government Body or Organization

If you have taken information from a brochure published by an organization, use this format
to create the reference entry.

The title of the brochure is written in sentence case, in italics.
Immediately after the last word of the title, insert the word “Brochure”
between two square brackets; this is a description of the document you
have taken your information from.

Group Author. (Copyright Year) . Title of the brochure [Brochure]. Publisher’s Name.
URL

Typically, the publisher will be the same as the group author, and therefore, will not be incorporated into a reference entry
with a group author.

Example:
Canadian Centre on Substance Use and Addiction. (2018). Canada’s low-risk alcohol

drinking guidelines [Brochure]. https://www.ccsa.ca/canadas-low-risk-alcohol-

drinking-quidelines-brochure
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Reference Materials
Dictionary / Encyclopedia Entry

If you have taken information from an online dictionary or encyclopaedia, use this format to
create the reference entry.

If the online dictionary or encyclopaedia is Input the name of The title of dictionary/encyclopedia is
constantly updated, use n.d. in the copyright the entry, written in written in sentence case, in italics.
year portion of the entry and use a retrieval sentence case. Input the word “In” before identifying
statement before the URL. the title of the
dictionary/encyclopedia.

Group Author. (Copyright Year) . Entry title. In Title of the online dictionary. Publisher’s

Name. Pet”eval date ] URL Typically, the publisher will be the same as the group author,

and therefore, will not be incorporated into a reference entry

If the source is updated regularly, input a retrieval statement with a group author.
before the URL. The URL must bring the reader directly to the

definition that you have taken your information from.

Example:
Oxford University Press. (n.d.). Canadian colleges. In Oxford learner’s dictionaries.
Retrieved May 5, 2020, from

https://www.oxfordlearnersdictionaries.com/definition/english/literacy
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Websites
Webpage Article from a Website with an Individual Author

If you have taken information from a webpage with an individual author, use this format to
create the reference entry.

The title of the
webpage is written
in italics, in
sentence case

are two dates listed, use the “Last Updated” date. Refer to the “Tips and Tricks
section for multiple ways to format a date.

Input the date as per the noted year/month/date of the publication. If there ‘ ‘

. If the article or webpage is constantly updating, input a retrieval
WebSIte Name. URL ‘ statement before the URL: Retrieved Month Date, Year, from URL.

The website name that houses the webpage
should be listed in the header of the website. It
may also be listed in the first part of the URL
(www.hrrreporter.com/..).

Author’s Surname, Author’s 1% Initial. (Year, Month Date) . Title of the webpage article.

Example:
Dobson, S. (2019, September 16). Edible cannabis could mean fresh challenges for

employers: Newly available products stronger, last longer than inhaled ones.

Canadian HR Reporter. https://www.hrreporter.com/focus-areas/training-and-

development/edible-cannabis-could-mean-fresh-challenges-for-employers/304573
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Webeage Article From a Website With a Group Author

If you have taken information from a webpage with a group author, use this format to create

the reference entry.

Input the date as per the noted year/month/date of the publication. If there
are two dates listed, use the “Last Updated” date. Refer to the “Tips and Tricks” The title of the webpage is written in
section for multiple ways to format a date. italics, in sentence case

Group Author. (Year, Month Date) . Title of the webpage article. Website Name., URL

If the article or webpage is constantly updating, input a retrieval

The website name that houses the webpage
statement before the URL: Retrieved Month Date, Year, from URL.

should be listed in the header of the website. It
may also be listed in the first part of the URL

(www.cbc.ca/..). If the group author’s name is
the same as the website’s name, omit the
website name portion of the entry.

Example:
Mayo Clinic Staff. (2019, August 21). Women'’s health. Mayo Clinic.

https://www.mayoclinic.org/healthy-lifestyle/womens-health/basics/womens-

health/hlv-20049411
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Webeage Article From A Website With No Date

If you have taken information from a webpage without a noted copyright or posting date, use
this format to create the reference entry. Aside from the date section of the entry, the
reference entry will be formatted in the same format as the webpage by an individual or group
author, depending on your source.

Input “n.d.” between the round brackets in
the date section of the reference entry
because it stands for no date.

Group Author. (n.d.). Title of the webpage article. Website Name., URL

The website name that houses the webpage should be
listed in the header of the website. It may also be listed
in the first part of the URL (www.cbc.ca/..). If the group
author’s name is the same as the website’s name, omit
the website name portion of the entry.

Example:
Dancing to Eagle Spirit Society. (n.d.). Smudging and the four sacred medicines.

http://www.dancingtoeaglespiritsociety.org/medicines.php
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Webeage Article from a Website That is Designed to Constantly Update

If you have taken information from a webpage designed to constantly update, use this format
to create the reference entry. Aside from the URL portion of this example, the reference entry
will be formatted in the same format as the webpage by an individual or group author,
depending on your source.

Author’s Surname, Author’s 1% Initial . (Year, Month Date) . Title of the webpage article.

Website Name. Retrieved Month Date, Year, from URL

For a webpage that is designed to constantly update (election results, COVID-19 daily tally, etc.), in
the URL portion of the reference entry, write “Retrieved” followed by the date that you accessed
the information on the webpage, followed by the word “from” and then the URL that directly links
to the updating webpage.

Example:
Messacar, D., & Morissette, R. (2020, May 6). Work interruptions and financial vulnerability.
Statistics Canada. Retrieved May 6, 2020, from

https://www150.statcan.gc.ca/nl/pub/45-28-0001/2020001/article/00010-eng.htm

Visual Media & Audio-Visual Media
Graphic (Complete) From A Source

If you have taken an entire graphic from a source and have input/adapted that graphic in your
assignment, use the reference entry format for the type of document that you have taken the
graphic from.
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Infographic

If you have taken information from an infographic published by an organization, use this
format to create the reference entry.

The title of the infographic is written in sentence case, in italics.
Immediately after the last word of the title, insert the word “Infographic”
between two square brackets; this is a description of the document you
have taken your information from.

Group Author. (Copyright Year). Title of the infographic [Infographic]. Publisher’s

Name. URL

Typically, the publisher will be the same as the group author, and therefore, will not be incorporated into a reference entry
with a group author.

Example:

Health Canada. (2019). Canada’s food guide [Infographic]. https://food-

guide.canada.ca/en/food-quide-snapshot/

Film / Video

If you have input information from a film or video into your assignment, use this format to
create the reference entry.

Input the director’s name in the author Input the title of the film/vido in italic font, written in sentence case.
portion of the reference entry. If it s a Immediately after the title, in square brackets, write the word "Film” or
video, input the artist’s information. “Video” in the description area of the reference entry.

Director’s Surname, Director’s 1% Initial . (Copyright Year). Title of the film [Film].

Production Company’s Name. URL I Input a URL only if the film can be accessed online. I
Input the production company’s name for a film or the publishing
website’s name in the publisher’s position in the reference entry.

Example:
David, B., & Bravo, E. (2017). In a heartbeat [Film]. Ringling College of Art and Design.

https://www.nytimes.com/2017/08/04/movies/in-a-heartbeat-movie.html
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Image / Photograph

If you have input an image or photograph into your assignment, use this format to create the
reference entry. Reminder: you will need to have a copyright notation immediately under the
taken photograph in the body of your assignment.

Input the title of the photograph in italic font, written in sentence case.
Immediately after the title, in square brackets, write the word

Input the photographer’s name in the "Photograph” in the description area of the reference entry. If the
author portion of the reference entry. photograph does not have a title, only include the description area, and
choose a short description of the photograph that you have taken.

Photographer’s Surname, Photographer’s 1% Initial . (Copyright Year) . Title of the image /

photograph [Photograph]. Publisher’s Name. URL

Typically, the publisher will be the name of the website that you retrieved the photograph |
from.

Example:
Rees, S. (2020, May 7). The coronavirus has wiped out 95 per cent of demand for
Greyhound'’s routes in Canada [Photograph]. CBC.

https://www.cbc.ca/news/business/greyhound-canada-coronavirus-1.5559180
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Podcast Episode in a Series

reference entry.

If you have taken information from a podcast episode in a series, use this format to create the

Input the episode host’s name in the author portion
of the reference entry. In round brackets, identify
the person’s position.

Input the date of the
episode’s release date.

Host’s Surname, Host’s 1% Initial (Host). (Year, Month Date) .

Input the episode’s title, written in
regular font. Immediately after the
title, in round brackets, identify the
episode number.

Immediately after the episode
URL number, in square brackets, write
the description of the podcast: Audio
podcast or Visual podcast.

If you retrieved the
podcast from a website,
input the URL in the
reference entry. If you
retrieved the podcast
from an app, do not
include a URL.

Write the word “In”
followed by the title of the
podcast series, which is
written in italics, in title
case.

Title of the podcast episode

(No. #) JAudio or Visual podcast]. In Podcast Series’ Name._Production Company.

If known, write the
production company’s
name in title case.

Example:

Milano, A. (Host). (2020, March 9). Congressman David Cicilline (No. 45) [Audio podcast].

In Sorry Not Sorry. https://sorrynotsorrypod.com/episodes/congressman-david-

cicilline/
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TED Talk

If you have taken information from a TED Talk from the TED website, use this format to
create the reference entry.

Input the talk’s title, written in italics,
Input the presenter’s name in the author portion of Input the date of the in sentence case. Immediately after
the reference entry. talk’s release date. the title, in square brackets, write
“Video”.

Presenter’s Surname, Presenter’s 1%t Initial . (Year, Month, Date) . Title of the TED talk

Input the URL that leads

[Vldeo] TED. URL directly to the TED talk on

the TED website.

In the publisher’s
information,
write “TED”.

Example:
Rosenthal, A., & Thordarson, P. (2020, May). Which is better: Soap or hand sanitizer?

[Video]. TED.

https://www.ted.com/talks/alex rosenthal and pall thordarson which is better soap

or hand sanitizer
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Social Media
YouTube Video

If you have taken information from a YouTube video from YouTube, use this format to create
the reference entry.

Input the person’s name who uploaded the video to YouTube, not the person who Input the date the video was
created it. If you know the person’s username, input the username in square brackets posted on YouTube.

immediately after the name.

Uploader’s Surname, Uploader’s 1% Initial [Platform Handle]. (Year, Month, Date) . Title

the video.

qQf the YouTube video [Video]. , Streaming Platform’s Name. URL | Provide the direct link to |

Input the title of the YouTube video,
in italics, written in sentence case.
Immediately after the title, write,
“Video” in square brackets.

Input the name of the video
streaming website
(YouTube, Vimeo, etc.).

Example:

WritingClass. (2009, April 11). Schoolhouse rock prepositions [Video]. YouTube.

https://www.youtube.com/watch?v=yfEXXGMX2JM
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Twitter or Instagram Post

If you have taken information from a Twitter or Instagram post, use this format to create the
reference entry.

to Twitter or Instagram. Input the @username in square

Input the person’s (or group’s name) who uploaded the post Input the date the post was
uploaded to the platform.

brackets immediately after the name.

Author’s Surname, Author’s 1% Initial. [@username]. (Year, Month, Date) . Upto20

words of the content post [Description of audiovisuals]. Platform Name. URL

In the title area of the reference entry, write the post’s words to Input the name of the If the post is likely to be
convey the general idea of the post (up to 20 words). If there is an platform’s website removed, input a retrieval
image or audiovisual file accompanying the post, write its (Twitter, Instagram statement with the URL.
description in square brackets, immediately after the title. etc.)

Example:

Trump, D. [@realDonaldTrump]. (2020, May 7). As you know, | designated this day to be a
National Day of Prayer [Prayer photograph]. Twitter. Retrieved May 7, 2020, from

https://twitter.com/realDonaldTrump/status/1258432889303248896
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Facebook Page

If you have taken information from a Facebook page, use this format to create the reference
entry.

Input the person’s (or group’s) name who created the
Facebook page.

input n.d. for the date. If a date is given, however, input

If you have received information from the general page,
| the date the page was uploaded or changed.

Author’s Surname, Author’s 1% Initial. Or Group Narne. (Year, Month, Date) . Page title

[Description of audiovisuals]. Platform Name. URL it the page is likely to be

removed or changed,
input a retrieval statement

with the URL.
In the title area of the reference Input the name of the
entry, write the page’s title. If there social media
is a description to better help platform’s website
finding the information, input it in (Facebook)

square brackets.

Example:
Confederation College. (2020, May 7). Posts [Facebook Page]. Facebook. Retrieved May 7,

2020, from https://www.facebook.com/confederation
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Legal References
Treaty

If you have taken information from a treaty, use this format to create the reference entry.

Put the treaty’s full Input the signing date or approval date in
title in the author the date component.
position.

Name of the Treaty, Month Date, Year, URL

Reference Example:

Robinson-Superior Treaty, September 7, 1850, https://www.rcaanc-

cirnac.gc.ca/eng/1360945974712/1544619909155

Parenthetical In-Text Citation Example: (Robinson-Superior Treaty, 1850)

Provincial Law or Act

If you have taken information from a passed provincial law or act, use this format to create the
reference entry.

Put the law/act’s full Input the year the law was passed in the
title in the author date component.
position.

Name of Act or Law, Title Source § Section Number (Year). URL

Reference Example:

Highway Traffic Act, O. Reg. 160/20 § 2 (1990). https://www.ontario.ca/laws/regulation/200160

Parenthetical In-Text Citation Example: (Highway Traffic Act, 1990)

81


https://www.rcaanc-cirnac.gc.ca/eng/1360945974712/1544619909155
https://www.rcaanc-cirnac.gc.ca/eng/1360945974712/1544619909155
https://www.ontario.ca/laws/regulation/200160

Provincial (State) Supreme Court Decision

the reference entry.

If you have taken information from a provincial supreme court case, use this format to create

Input the name of the Input the volume and
case. Most often, this page information from

jurisdiction of the court case. For example,

is one party v. another the reporter. BC SC means British Columbia Supreme

party.

on the case.

In parenthesis, input the acronym for the Input the year the
decision was made

URL

Name v. Name, Volume # and Reporter Page (Precise Jurisdiction of the Court) (Court Year).

Reference Example:

Century Oils (Canada) Inc. v. Davies, CanLIl 2956 (BC SC) (1988).

https://www.canlii.org/en/bc/bcsc/doc/1988/1988canlii2956/1988canlii2956.html?searchUrl

Hash=AAAAAQAXZGF2aWVzIHYulGNIbnR1cnkgb2lscyAAAAAAAQ&resultindex=3

Parenthetical In-Text Citation Example: (Century QOils (Canada) Inc. v. Davies, 1988)

Federal Law or Act

If you have taken information from a passed federal law or act, use this format to create the
reference entry.

Put the law/act’s full Input the year the law was passed in the

title in the author date component.
position.

Name of Act or Law, Title Source § Section Number (Year). URL

Reference Example:

Access Canada Act, C.13 § 55 (2019). https://laws-lois.justice.gc.ca/eng/tablepublicstatutes/A.html

Parenthetical In-Text Citation Example: (Access Canada Act, 2019)
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Federal Supreme Court Decision

If you have taken information from a Federal Supreme Court case, use this format to create
the reference entry.

Input the name of the Input the volume and In parenthesis, input the acronym for the Input the year the
Fase. Most often, this page information from jurisdiction of the court case. For example, decision was made
is one party v. another the reporter. S.C.C. means Supreme Court of Canada. on the case.

party.

URL

Name v. Name, Volume # and Reporter Page (Precise Jurisdiction of the Court) (Court Year).

Reference Example:

Brooks v. Canada Safeway Ltd., 10 C.H.R.R. d/6183 (S.C.C.) (1989). https://www.cdn-hr-

reporter.ca/hr topics/sex-discrimination/sex-discrimination-includes-pregnancy

Parenthetical In-Text Citation Example: (Brooks v. Canada Safeway Ltd., 1989)
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